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ONLINE RESOURCES 
The RVA web site is: http://rva.cs.illinois.edu.  Project information, image gallery and information 

and links for downloads are available there. 

Software updates and downloads are available through github (https://github.com/shaffer1/RVA).  

Contact Us: rva-support@illinois.edu 

 

http://rva.cs.illinois.edu/
https://github.com/shaffer1/RVA
mailto:rva-support@illinois.edu
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RESERVOIR VISUALIZATION AND ANALYSIS SOFTWARE 

Overview 

RVA was developed to provide an integrated data visualization and analysis environment to 

support management of oil and gas reservoirs, particularly mature oil reservoirs being managed 

through tertiary recovery strategies known also as enhance oil recovery (EOR) strategies. 

The RVA software is a plugin to ParaView, an open-source 3-D visualization and analysis software 

package.  The latest RVA build, source code, demonstration data sets and documentation are 

available free of charge from the project web site (http://rva.cs.illinois.edu).   

RVA is intended to open a range of data files frequently used by petroleum geologists and engineers 

involved with EOR projects, and to provide a suite of tools and tutorials for analyzing these varied 

data sets.  Specific emphasis is placed on the development of novel tools for visualization and 

analysis of these complex data sets.   

Currently, the RVA plugin allows for reading and importing of files associated with Isatis, a leading 

geostatistical analysis and simulation software package (Geovariances, France), UTCHEM, the 

advanced multiphase, multicomponent compositional, variable temperature reservoir simulator 

(the Center for Petroleum and Geosystems Engineering, University of Texas at Austin), ArcGIS 

shapefiles (ESRI), and grids in the Z-MAP Plus mapping software format.   The Isatis functionality 

allows the user to access native Isatis project files via the GTXServer software development kit.  

Information on GTXServer is provided below. UTCHEM readers within the RVA plugin are for 

output files associated with version 9.x of UTCHEM.  

RVA functionality builds on the functionality inherent in ParaView.  In addition, RVA will provide 

additional functionality that is not available through the standard ParaView builds.  This RVA Users 

Manual will provide an overview of the ParaView concepts and tools that are critical for operating 

RVA.  It will also provide instruction on the use of custom RVA tools and guidance on the use of RVA 

for common data visualization and analysis problems associated with EOR field management.  

Additional information on the use of ParaView can be obtained from the ParaView web pages 

(http://paraview.org).  

RVA Installation 

RVA currently runs on ParaView 3.14.1 for Microsoft Windows.  Current and previous stable 

versions of ParaView are available at the ParaView download page.  To install the current build of 

the RVA software, either download and run the installation executable, or download the zip folder 

with the plugin dlls and move those to the desired directory.  These files can be found on the 

Releases page at the RVA github site. 

After installing ParaView and the RVA plugins, launch ParaView..  In the Tools Menu, select Manage 

Plugins.  In the popup window, under the Remote Plugins table, select Load New.  Navigate to the 

directory in which the RVA plugin was installed and select the first of the RVA dlls, 

RVA_Core_Plugin. Then, under the Local Plugin table, select Load New.  Navigate to the directory in 

http://rva.cs.illinois.edu/
http://www.geovariances.com/
http://www.cpge.utexas.edu/?q=UTChem_GI
http://esri.com/
http://paraview.org/
http://www.paraview.org/download/
https://github.com/shaffer1/RVA/releases
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which the RVA plugins were installed and select the same dll.  Repeat this process for each of the 

RVA dlls, then close the Plugin Manager.  RVA v. 2.5.2 has 5 dlls: RVA_Core_Plugin, 

RVA_ISATIS_Plugin, RVA_UTChemReaders_Plugin, ShapefileReader, and ZMAPPlusReader.  As you 

successfully load the RVA dlls, the banner at the top of the GUI will include, “RVA @ UIUC version 

2.5.2,” there will be an RVA menu in the menu bar, and when an actionable data layer is loaded, an 

RVA Submenu will appear in the Filters Menu. 

Structure of the User Manual 

This User Manual has been designed to help RVA users interact with their data as quickly as 

possible.  Because RVA is a plugin to ParaView, there are many menus and buttons that are part of 

the standard ParaView interface and are available through RVA.  However, this manual will only 

address key concepts in ParaView and critical parts of the ParaView interface. Most of the manual 

will focus on using Paraview-RVA to open, visualize and analyze data associated with oil reservoir 

simulations.  Rather than work through an exhaustive discussion of the menus, this manual has 

been structured in a tutorial-based, question and answer format.  This should allow the user to 

more quickly find solutions to problems or questions they want to address with RVA. 

Users looking to expand their visualization and analytical capabilities within RVA are encouraged to 

explore the ParaView web site and to learn more about ParaView functionality.   

RVA AND RESERVOIR DATA  
Reservoir visualization and analysis in ParaView-RVA consists of three steps: reading in data, 

filtering relevant data, and data rendering. As with all visualization tools, the first question one 

must answer is how to get your data into the visualization program. It is often the case that 

reservoir modeling and simulation software produces output files in proprietary formats. RVA has 

been developed to utilize the software development kit (SDK), GTXServer, to access Isatis files 

directly.  Files from UTCHEM v.9.x, ArcGIS shapefiles and Z-Map Plus-format grids can be identified 

and imported directly from the File menu, without the use of an external SDK.  In this section, we 

provide steps to import geologic models generated using Isatis, simulation output files generated 

by UTCHEM, shapefiles and zmap files.  

RVA and Isatis Data 

Isatis project data are managed in a hierarchical, binary file structure.  The Isatis developer, 

Geovariances, has provided the SDK, GTXserver, to allow programmers access to the native Isatis 

file structure.  For RVA to read Isatis files, therefore, the GTXserver software needs to be installed 

and running.  Procedures describing the installation and use of GTXserver are provided below.   

GTXserver Installation 

The Geovariances web site recommends working with GTXserver versions that are consistent with 

the Isatis version that created the files.  

http://paraview.org/
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Download and install the appropriate GTXserver zip file from 

http://www.geovariances.com/en/spip.php?page=GTXserver. 

This release of RVA is based on GTXserver 2011.2.  If you have difficulties with opening Isatis 

project files, either consult the Geovariances web page, or contact us for additional guidance.   

GTXserver Configuration 

After downloading and extracting GTXserver, navigate to the folder C:\GTXserver\bin\winnt to find 

the GTXserver application. Create a shortcut for the application on your Desktop. Open the 

Properties dialog box by right clicking on the shortcut and selecting Properties. If you have 

saved GTXserver to your C drive then, in the Properties dialog box, set Target to: 

C:\GTXserver\bin\winnt\GTXserver.exe –multisession 

If you have saved GTXserver elsewhere on your machine, set Target to the appropriate path.   

The option “–multisession” must follow the pathname of the GTXserver executable. 

When the target is properly specified, click to save and apply these changes.  

 

Figure 1: Change the Target field to C:\GTXserver\bin\winnt\GTXserver.exe –multisession, click 

OK. 

http://www.geovariances.com/en/spip.php?page=gtxserver
http://www.geovariances.com/en/spip.php?page=gtxserver
mailto:rva-support@illinois.edu
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Launch GTXserver by double clicking the shortcut that you created, above. GTXserver is now 

running and RVA is ready to read your ISATIS files.  

Note: The GTXserver by default connects to port 5500. If you would like to change the port it uses, 

then use the “port” option in the Target field of the Properties dialog box ( –port XXXX). 

GTXserver MUST BE RUNNING on your system every time you want to access an Isatis file.  

Loading an Isatis Data Set 

We provide example Isatis data for use in RVA. Download the Isatis demonstration case studies 

from the RVA website. Save the CaseStudies zip file and extract it to a convenient directory in your 

system.  

Open the Start Menu and type %APPDATA% in the search field. Click on the folder called Roaming. 

Then navigate to the folder called Geovariances followed by the folder Isatis. Within the Isatis folder 

you will be able to see a file called study_names.def (Fig 0.1).  If the user does not have ISATIS, this 

folder may not exist.  However, the folder gets created once the connection between the machine 

that the server is running on and RVA is established (see below). 

 

Fig 0.1: study_names file in the AppData\Roaming\Geovarianes\Isatis folder. 

http://rva.cs.illinois.edu/
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Important: GTXserver and Isatis MUST NOT BE RUNNING when you open this file, or the changes 

you make will be overwritten 

Open study_names.def by right clicking on the file and selecting Open with and then Notepad. 

Modify the study_names.def file to add Demo and RVA_Demo2 as shown in Fig 0.2. Save and 

close study_names.def. 

Note: Users with an active Isatis license should find the study_names.def file already contains the 

names of studies loaded in their system previously. However it is possible that those studies may 

not be compatible with the GTXserver version you downloaded. To make sure your GTXserver 

installation and configuration were successful, add in the demonstration data set you downloaded 

from the RVA site.  

Fig 0.2: Modified study_names file to include the RVA case studies –Demo and RVA_Demo2. 

Navigating Isatis File Structure 

Start RVA. Click on the RVA menu and select Import ISATIS Data. 

The Isatis import button creates an object called ISATISReader1 displayed in the Pipeline 

Browser. Next to the object cube you should see an icon that looks like an eye. The icon at this time 

will be grey in color indicating that no data can be seen in the view port as yet. The Properties 

tab in the Properties Panel panel shows seven fields all of which can be customized as per the 

choice of you. The GTX Server Port field will contain the port number that GTXserver is 

connected to. If GTXserver is running locally then type ‘localhost’ in the GTX Server Host field. 

The Refresh button must be clicked every time an RVA object is created in ParaView or when the 

port or the host is changed with the GTXserver connection. Clicking on the Refresh button 

establishes a connection between the machine that the server is running on and RVA so that the list 

of studies available on that machine become available to the local machine. If you are connected to a 

GTXserver running on the local machine then the studies available locally become available for 

reading into RVA. The text box next to the Refresh button will tell you the status of the connection 

every time it is clicked (Fig 0.2). The GTX Study field is a drop down list consisting of a list of 

studies that are populated by the connection to GTXserver. Selecting a valid study in this field will 

allow you to select a directory in the GTX Directory drop down list populated by the connection 

to GTXserver. Selecting a valid directory in this field will allow you to select a file in the GTX File 
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Name field. It contains the list of files available in the directory chosen above.  Length Units can 

be used to view data scaled to the selected unit. Once all the fields are instantiated, click the Apply 

button to load the data.  

Note: Each time a new study/file/directory is chosen, the Apply button needs to be clicked. You 

have the additional option of Auto-Applying option in RVA. Navigate to Edit > Settings, check 

the Auto Accept box, click Apply and then OK.  

RVA and UTCHEM Data 

RVA v2.5.2 is compatible with UTCHEM v9.3. This version contains readers for several output files (.PROF, 

.HIST, .ALKP, .CONCP, .PRESP, .SATP, .VISC, .COMP-OIL, .COMP-ME, and .COMP-AQ). UTCHEM 

output files are in ASCII format, allowing RVA to load these files directly through the Open 

command in the File Menu.  

UTCHEM v9.3 demo data are available from the RVA project web site.  A zip file contains several 

different demonstration projects, each with several output files.  Descriptions of UTCHEM demo 

datasets are located in the Appendix. 

Cartesian and curvilinear 2D and 3D grids are supported. One-dimensional grids are not supported. RVA 

supports the UTCHEM grid parameter combinations in the table below. For further explanation of 

UTCHEM output files and grid specification, please refer to the UTCHEM User’s Guide and Technical 

Documentation at http://www.cpge.utexas.edu/?q=UTChem_GI. 

ICOORD IDXYZ 

1 (Cartesian coordinate system) 0 (Globally Constant) 

1 (Cartesian) 

2 (Globally Variable) 

4 (Curvilinear grid) 0 (Globally Constant) 

1 (Cartesian) 

2 (Globally Variable) 

 

Tips and Tricks for Loading UTCHEM Data 

To begin visualizing a UTCHEM v9.3 demo simulation, open and load your data set. The RVA file 

reader requires the UTCHEM input files be named INPUT and HEAD, and not contain file extensions. 

See the provided demo datasets for examples.  

This current RVA release can read in aqueous phase and oleic phase flux data from the PROF output 

file. Phase flux must be printed to the PROF file (IVEL=1); otherwise, the error “No phase vel. in 

.PROF file, IVEL equals 0.” will be returned. 

The RVA file reader will load UTCHEM concentrations files which contain NaN’s; however, an error 

message will appear stating NaN’s were found. 

 

http://rva.cs.illinois.edu/downloads/UTChem-RVA-Examples-1-Redist.zip
http://www.cpge.utexas.edu/?q=UTChem_GI
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RVA and Other Data 

ParaView-RVA 2.5.2 is able to load other file types, through the File Menu > Open submenu, 

specifically including ArcGIS Shapefiles, and Z-MAP Plus-formatted grid files.  In addition to these 

file types, for which custom reader utilities were added, ParaView is able to read a large suite of file 

types.  See the ParaView web site for a more complete listing of the file types that ParaView can 

read. 

RVA and Demonstration Data Sets 

Several demonstration project files are available for use with RVA.  

All of the tutorials in this User Manual were made using demonstration data files that are available 

through the RVA web site (http://rva.cs.illinois.edu).  Two files, Strat2fields.vts and 

BoreholeData.vtu, were created from an Isatis project and contain a 3-D reservoir model with 

porosity and permeability values, and a suite of 5 wells with wireline log and sample data..  Several 

UTCHEM demonstration simulations are included with the demonstration data.  The correct file 

names will be listed in each tutorial within this User Manual, to help the reader replicate the 

tutorial results.   

Font and Typographic Style Conventions Used in this Manual 

This User Manual will use specific font and style notation to simplify instructions for completing 

specific tasks and when referring to parts of the RVA or ParaView interface.  All instructions 

and interface names will use the Courier New font. 

Instructions for carrying out any procedure will use a carrot notation (>) to specify the flow of user 

interface choices.  For example: 

Properties Panel > Display Tab > Color > Edit Color Map > Color Scale 

Tab > Choose Preset Button = Blue to Red Rainbow > OK > Close 

The above instructions specify how to select a preset color map (Blue to Red Rainbow) for an 

object.  In this example, in the Properties Panel, on the Display Tab, the Edit Color 

Map button was selected.  In the pop up window for that button, the Choose Preset Button 

was selected.  This brought up another window on which the Blue to Red Rainbow preset 

color map was selected.  The Ok and Close buttons were selected to finalize this choice. 

GETTING TO KNOW PARAVIEW-RVA 
RVA is built on top of ParaView, an open source visualization and analysis package. The RVA plug-in 

adds a suite of advanced data filters, a global vertical scaling toolbar (Global Z Scale), and flow 

visualization capabilities relevant to reservoir analyses. The ParaView Home Page provides 

information on the background and structure of ParaView and links to a range of ParaView 

resources.  There is an online users guide to ParaView, another online help for the current stable 

ParaView release, a tutorial for version 3.12, a group of more advance tutorials, newsgroups and 

http://rva.cs.illinois.edu/
http://paraview.org/
http://paraview.org/Wiki/ParaView/Users_Guide/Table_Of_Contents
http://paraview.org/OnlineHelpCurrent
http://www.cmake.org/Wiki/images/c/c6/ParaViewTutorial312.pdf
http://visualization.hpc.mil/wiki/ParaView
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user groups for general ParaView use.  These resources do NOT cover RVA-specific tutorials or 

issues.   

This part of the User Manual discusses critical aspects of the generic, ParaView structure and 

functionality.  The standard ParaView User Interface is shown in Figure 1.  This figure highlights the 

modular nature and flexibility of the Paraview environment.  Of particular note, the Pipeline 

Browser, Properties Panel, toolbars and varied view window types that are readily accessible.  

Figure 2 provides a view of the RVA User Interface.  This figure shows the distinctive RVA menu 

containing RVA filters, Global Z Scale, and the banner text that contains the RVA @ UIUC reference 

and the build version.  

 

Figure 1. The ParaView User Interface.  (from: 

http://paraview.org/Wiki/ParaView/Users_Guide/Introduction) 

 

http://paraview.org/Wiki/ParaView/Users_Guide/Introduction
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Figure 2.  RVA User Interface.  Note the RVA menu, filters, Global Z Scale, and the RVA@UIUC with build 

version in the banner. 

In ParaView, there will always be one “active” view, one “active” module or object within the 

visualization pipeline, and one “active” selection.  The information displayed in any region of the 

User Interface always relates to these active entities (ParaView Users Guide). 

Within ParaView, there are three basic steps to visualizing data: reading the data into ParaView, 

filtering or processing the data in some way, and rendering or drawing some aspect of the data.  

RVA, as a plugin to ParaView, is focused on simplifying the processes of reading data into ParaView 

and of filtering the data, all with the goal of simplifying visualization and analysis of reservoir 

simulation results and thereby improving the management of mature oil fields. 

ParaView takes these three steps and integrates them with an architecture called the visualization 

pipeline, which allows a user to read in data and run the data through a sequence of processes, or 

filters, each of which provide a different view of the data.  ParaView has over one hundred different 

filters that can be used to manipulate various data types.  Since the filters are specific to the type of 

data processed, not all filters work on all data sets.  When a filter is unavailable for an active data 

object, it is greyed out in the menu. 

http://paraview.org/Wiki/ParaView/Users_Guide/Introduction
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Pipeline Browser 

The Pipeline Browser is where the visualization pipeline is recorded and controlled from 

(ParaView Users Guide).  As such interaction with the Pipeline Browser is a critical component of 

RVA.  The following describes some of the more important aspects of the Pipeline Browser. 

Visibility “Eye” Icon 

On loading data the visibility, or eye, icon next to the object in the Pipeline Browser turns from 

grey to black. This indicates whether or not an object is rendered in the active window.  Clicking 

on the eye icon changes the icon from black to grey and correspondingly toggles the object from 

rendered to not rendered. This eye icon is useful when multiple objects are available for viewing. 

The behavior of the Eye Icon can vary when multiple display windows are used.  Use of multiple 

display windows will be covered later in the manual. 

Renaming Objects 

Objects created can be renamed in the Pipeline Browser. The objects by default are named 

alphanumerically with the name of the object followed by the creation number. Double clicking on 

this name opens a text edit box where you can rename the object to be more informative. 

Deleting Objects 

You can right click on an object for a list of actions to take on the object. Clicking on Delete will 

remove the object from the Pipeline Browser. 

Properties Panel 

The Properties Panel is where the various parameters of the active module within the 

visualization pipeline are displayed and controlled. ParaView provides various methods to view 

data and are listed in the View Menu.  

Properties Tab 

The Properties Tab of the Properties Panel holds information on the filters and objects 

created in the Pipeline Browser. All of the fields in the Properties Tab change the 

configuration of the objects.  

The Apply button must be clicked each time there is change made to an object in the Properties 

Tab.  ParaView has the additional option of auto-applying changes made to the Properties 

Tab. To auto-apply changes to the Properties Tab: 

Edit Menu > Settings > General Settings >Auto Accept = check/uncheck > OK 

Display Tab 

In the Display Tab the following are useful functions for viewing data objects for better: 

 Zoom To Data – This button centers all of the data objects that are turned on in the active 

viewing window. 

http://paraview.org/Wiki/ParaView/Users_Guide/Introduction
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 Color by – This field applies color to the data set according to the variable selected. In the 

drop down a list of variables appear and you can then use any one of the variables to color 

the data set. To see the list of variables corresponding to a given data object the 

Representation field (details given below) needs to be set to anything except Outline. 

 Edit Color Map… - This button opens a widget to adjust the color scales on the data.  

The Choose Preset button in the Color Scale tab shows a list of color schemes 

available with the data. The checkbox for Use Logarithmic Scale sets colors using a 

log scale. The Color Legend tab displays the legend for the current variable being used 

on the view port. 

 Set Ambient Color… - This drop down list can be used to set solid color to the data 

using the colors provided by ParaView.  

 Show cube axes – When checked, this box displays the appropriately labeled axes for 

the selected object.  The Edit button allows for customization of the drawing options for 

each of the axes. 

 Representation – This drop down list consists of different ways to draw an object. To 

see the variables for the object you must set the Representation to anything except 

Outline.  The list of variables can be viewed through the dropdown list in Color > Color 

by. 

 Point Size/Line Width/Opacity – Increasing or decreasing these values changes 

the appearance of the data accordingly. 

 Translate/Scale/Orientation/Origin – These fields in the Display tab 

transform the data based on the given input. The data only changes when the values are 

typed into the boxes and then clicking the mouse away from the boxes (i.e. losing focus from 

the boxes).  In most cases this operation needs to be followed by clicking on Zoom To 

Data to center the data correctly. 

Unlike the Properties Tab there is no need to click the Apply button when fields are changed in 

the Display Tab.  Pressing the TAB button or selecting another field in the Display Tab 

applies the changes that have been made.  Most of the above operations can also be done using the 

icons in the Representation and Active Variable Controls toolbars from the ParaView 

main window. 

Information Tab 

The Information Tab in the Properties Panel provides information on the data objects 

including the Type, Number of Cells, Number of Points, the Data Arrays/Variable List, the Extents 

and the Bounds. The fields indicate the data structure used to represent the data, the volume of 

interest and the number of samples present in the given data set. 

Standard ParaView Filters 

As mentioned above, ParaView has over one hundred filters for processing the information 

associated with active objects in the visualization pipeline. These filters are accessed through the 
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Filters Menu on the MenuBar. The filters are displayed under seven submenus: Recent, 

Common, Data Analysis, Material Analysis, Statistics, Temporal, and 

Alphabetical. ParaView-RVA has an additional RVA submenu listing the RVA filters.  

Recent Submenu 

The Recent submenu lists the 10 most recent filters used. 

Common Submenu 

Common displays the filters that most ParaView users will use most commonly. You can find 

shortcuts to these filters on the Filters Toolbar. Some of the common filters used are: 

 Glyphs - This filter produces glyphs at each point in the selected data set. Different shapes 

can be used for the glyphs like cone, arrow, line, sphere or 2D glyph. 

 Threshold – This filter extracts the subset of the data set whose scalars lie within the 

specified range. The Lower Threshold and Upper Threshold sliders indicate the 

range of scalars to retain in the data set.  

 Contour – This filter calculates the Isolines/Isosurfaces of the selected point centered 

scalar array in the data set. The available scalars are listed in the Contour by dropdown 

list. To add a single contour value, select the New Value field in the Isosurfaces 

section of the Properties tab and type a new value. To add several evenly spaced values 

first click on Delete All button which deletes the initial values present, then click New 

Range and type in the values in the From, To and Steps text boxes to specify the 

Contour values and the spacing interested. If you would like to space the contours using a 

Logarithmic scale instead of a liner scale then check the Use Logarithmic Scale 

option in the dialog box and press OK to add the values or Cancel to not add them. The 

Contour filter operates on any data set that has atleast one point-centered scalar array. 

The output is a polygonal mesh. You can also check the Compute Normals, Compute 

Gradients, Compute Scalars and the corresponding computation is performed and 

the contours are Displayed accordingly. 

 Slice – This filter extracts the portion of the data set along a plane. The plane can be 

specified by using the interactive widget/axes or by manually typing in the values in the 

Transformation box. Using the Slice Offset Values you can also slice a portion of 

the data set using an offset from the original plane function. The Offset Values can be added 

in a similar fashion by adding New Value/New Range in the dialog box. 

 Clip – This filter clips away a portion of the data set depending on the Clip Type 

selected in the Properties tab of the Properties Panel. You have the choice of 

selecting a plane, box, sphere or scalar. The Clip filter returns the portion of the data set 

that remains after the clip. If the scalars option is chosen then you must select the scalar 

array by which to clip. Clip then returns the set of those scalars that are larger than the 

clip Value.  Checking the Inside Out box will return the portion that has been clipped 

rather than the portion that remains after the clip. 
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Data Analysis Submenu 

These filters can be used to analyze data quantitatively. They can plot data as graphs and 

histograms on different variables. 

Material Analysis Submenu 

These filters are used for processing data of materials.  

Statistics Submenu 

These filters provide descriptive statistics of data. 

Temporal Submenu 

These filters can be used to analyze data that changes over time.  

Alphabetical Submenu 

This option lists all the available filters in an alphabetical order. The screenshots given at the end of 

this manual illustrate the use of some of these filters. 

 

RVA Filters 

The following tutorials detail how to use RVA filters: Connected Threshold, Connected 

Threshold with Custom Source, Sum, and Cut Between Wells. UTCHEM demo data set 

EX20 is used for all demonstrations. These tutorials do not need to be completed in sequential order and do 

not build off one another. 

Connected Threshold Filter 

The Connected Threshold filter extracts cells that have cell scalars in a specified range and are 

connected to each other by edges or faces of cells. Each connected group of cells is numbered in the output 

array. Cells with cell scalars which fall out of the specified range are assigned a “0” in the output array. 

Applying a Threshold filter after the Connected Threshold filter is useful to extract only the 

interconnected cells. To begin this tutorial, open and load UTE204.PERM. 
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Fig X: 

 
Fig. X.  

This tutorial combines the Connected Threshold and Threshold filters to extract connected cells 

with high permeability which represents a buried river channel. Step 1 details how to use the Connected 

Threshold filter to extract cells connected to each other and have permeability values greater than 1500 

mD. The cells with permeability values less than 1500 mD are assigned the scalar value “0” in the output 

array. Steps 2 and 3 visualize the results from Step 1 (Fig. X) Step 4 demonstrates how to extract only the 
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connected cells by applying a Threshold filter to the output array from Step 1. Steps 5 through 8 visualize 

only the connected cells and an outline of the reservoir is added for context (Fig. X).  

1. Click on UTE204.PERM in the Pipeline Browser. 

a. Filters Menu > RVA Sub Menu = Connected Threshold 

b. Properties Panel > Properties Tab >  

I. Scalars 1 = Permeability 

II. Filter Mode = Only Scalar 1 

III. Threshold Range 1 =  

1. Left Box (min) = 1500 

2. Right Box (max) = 3760 

3. Result Array Name = HighK-Connectivity 

IV. Click Apply 

2. Click on ConnectedThreshold1 object in the Pipeline Browser. Turn on its visibility by 

clicking on the eye icon. 

3. Properties Panel > Display Tab >  

a. Color by = HighK-Connectivity 

b. Color by > Edit Color Map >  

I. Color Legend Tab > check Show Color Legend 

II. Click Apply 

III. Click Close 

c. Style > Representation = Surface with Edges 

4. To extract only the connected cells from the Connected Threshold filter in Step 1: 

a. Filters Menu > Common Sub Menu = Threshold 

b. Properties Panel > Properties Tab >  

I. Scalars = HighK-Connectivity 

II. Lower Threshold = 1 

III. Upper Threshold = 20 

IV. Click Apply 

5. Click on Threshold1 object in the Pipeline Browser. Turn on its visibility by clicking on the 

eye icon.  

6. Properties Panel > Display Tab >  

a. Color by = HighK-Connectivity 

b. Color by > Edit Color Map >  

I. Color Legend Tab > check Show Color Legend 

II. Click Apply 

III. Click Close 

c. Style > Representation = Surface with Edges 

7. Click on the ConnectedThreshold1 object in the Pipeline Browser. 

8. Properties Panel > Display Tab >  

a. Style > Representation = Outline  

b. Style > Line Width = 2.00  
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You should be able to see an image resembling Figure X. If this image is not drawing on your screen, 

reference the tips to resetting the camera and viewing post-processed data. 

Connected Threshold with Custom Source 

The Connected Threshold with Custom Source filter acts similar to the Connected 

Threshold filter, however the connections between cells begin at a selected Seed Point. In this tutorial, the 

connections will begin at a well.  

To begin this tutorial, open and load UTE204.PERM and UTE204.HIST07. When loading well history files, 

the viewing area will automatically split into a 3D View and a Spreadsheet View. Close the 

Spreadsheet View by clicking the X icon in the top-right corner of the Spreadsheet View 

viewing area. For this tutorial, we need to begin with a single 3D View. Please see the Working with Wells 

tutorial for additional information. 

This tutorial combines the Connected Threshold with Custom Source and Threshold filters to extract cells 

with permeability values greater than 1500 mD, connected to each other, and connected to a well. Steps 1 

through 4 details how to use the Connected Threshold with Custom Source filter. Step 3 

shows how to specify the data set and seed point. Step 4 demonstrates how to specify the range of 

permeability values. The cells with permeability values less than 1500 mD are assigned the scalar value “0” in 

the output array. Steps 5 and 6 visualize the results from the Connected Threshold with Custom 

Source filter (Fig. X) Step 7 demonstrates how to extract only the connected cells by applying a 

Threshold filter to the output array. Steps 8 through 11 visualizes only the connected cells and an outline 

of the reservoir is added for context (Fig. X). 

 

 

Fig. X.  
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Fig. X.  

1. Click on UTE204.PERM in the Pipeline Browser. 

2. Filters Menu > RVA Sub Menu = Connected Threshold with Custom 

Source 

3. A Change Input Dialog window will appear containing options for Available Input 

Ports on the left and available data objects on the right. For each Available Input Port, 

we need to choose a data object. 

a. Available Input Ports > Click Input. On the right, choose 

UTE204.PERM. 
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b. Available Input Ports > Click Seed Points. On the right, choose the 

position object of UTE204.HIST07. 
 

 

 

c. Click OK  

4. Properties Panel > Properties Tab > 

a. Filters Mode = Only Scalar 2 
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b. Scalars 2 = Permeability 

c. Threshold Range 2 = 1500, 3760 

d. Result Array Name = HighK-Connectivity 

e. Click Apply 

5. Click on ConnectedThresholdWithCustomSource1 object in the Pipeline Browser. Turn on 

its visibility by clicking on the eye icon. 

6. Properties Panel > Display Tab >  

a. Color by = HighK-Connectivity 

b. Color by > Edit Color Map >  

I. Color Legend Tab > check Show Color Legend 

II. Click Apply 

III. Click Close 

c. Style > Representation = Surface with Edges 

7. To extract only the connected cells: 

a. Filters Menu > Common Sub Menu = Threshold 

b. Properties Panel > Properties Tab >  

I. Scalars = HighK-Connectivity 

II. Lower Threshold = 0.1 

III. Upper Threshold = 1 

IV. Click Apply 

8. Click on Threshold1 object in the Pipeline Browser. Turn on its visibility by clicking on the 

eye icon.  

9. Properties Panel > Display Tab >  

a. Color by = HighK-Connectivity 

b. Color by > Edit Color Map >  

I. Color Legend Tab > check Show Color Legend 

II. Click Apply 

III. Click Close 

c. Style > Representation = Surface with Edges 

10. Click on the ConnectedThresholdWithCustomSource1 object in the Pipeline 

Browser. 

11. Properties Panel > Display Tab >  

a. Style > Representation = Outline  

b. Style > Line Width = 2.00  

 

You should be able to see an image resembling Figure X. If this image is not drawing on your screen, 

reference the tips to resetting the camera and viewing post-processed data. 
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Cut Between Wells Filter 

This tutorial demonstrates the use of the Cut Between Wells filter to extract and visualize a slice of 

permeability between two wells. To begin this tutorial, open and load UTE204.PERM, UTE204.HIST05, and 

UTE204.HIST07.  

 

When loading well history files, the viewing area will automatically split into a 3D View and a 

Spreadsheet View. Close the Spreadsheet View by clicking the X icon in the top-right corner of 

the Spreadsheet View viewing area. For this tutorial, we need to begin with a single 3D View. Please 

see the Working with Wells tutorial for additional information. 

 

Fig X: 

Steps 1 through 4 demonstrate how to apply the Cut Between Wells filter. Step 3 explains how 

to select the wells and specify the data object to be sliced. Steps 5 and 6 visualize the reservoir 

permeability field at low opacity. Steps 7 and 8 visualize the permeability slice results from the Cut 

Between Wells filter. 

1. Click on UTE204.PERM in the Pipeline Browser. 

2. Filters Menu > RVA Sub Menu = Cut Between Wells 

3. A Change Input Dialog window will appear, containing options for Available Input 

Ports on the left and available data objects on the right. For each Available Input Port, 

we need to choose a data object. 

a. Available Input Ports > Click Data Set. On the right, click on 

UTE204.PERM. 
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b. Available Input Ports > Click Well One. On the right, click on the position 

object of UTE204.HIST05. 

 

 

 

c. Available Input Ports > Click Well Two. On the right, click on the position 

object of UTE204.HIST07. 
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d. Click OK 

4. Properties Panel > Properties Tab > Click Apply 

5. Click on UTE204.PERM in the Pipeline Browser. Turn on its visibility by clicking the eye 

icon. 

6. Properties Panel > Display Tab >  

a. Color by = Permeability 

b. Color by > Edit Color Map >  

I. Color Legend Tab > check Show Color Legend 

II. Click Apply 

III. Click Close 

c. Style > Representation > Surface with Edges 

d. Style > Opacity = 0.2 

7. Click on CutBetweenWells1 object in the Pipeline Browser. Turn on its visibility by clicking 

the eye icon. 

8. Properties Panel > Display Tab >  

a. Color by = Permeability 

b. Style > Representation > Surface with Edges 

 

You should be able to see an image resembling Figure X. If this image is not drawing on your screen, 

reference the tips to resetting the camera and viewing post-processed data. 
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Sum Filter 

This tutorial demonstrates the use of the Sum filter to calculate total oil saturation in a reservoir. To begin 

this tutorial, open and load UTE204.SATP.  

 

Steps 1 through 3 demonstrate how to apply the Sum filter to the data set. The Sum filter calculates the sum 

of each array in the .SATP data object. The total saturation for each phase is calculated. The results of the 

Sum filter can be viewed in a Spreadsheet View (steps 4 and 5).   

 

 
Fig X: 

 

1. Click on UTE204.SATP in the Pipeline Browser. 

2. Filters Menu > RVA Sub Menu = Sum 

3. Properties Panel > Properties Tab > Click Apply 

4. Open a second Layout Tab by clicking on the + icon located in the top right corner of the viewing 

area. Select Spreadsheet View. 

5. Properties Panel > Display Tab >  

a. Check Show data 

b. Select Attributes to Show = Field Data 

 

The value of total oil saturation is located in the first column: 4210.07. 

 

RVA Volumetrics Filter 

To be completed… 
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Basic ParaView-RVA Skills 

How do I load my dataset? 

Most datasets can be opened through the File Menu, Open command.   

File Menu > Open = choose a demo file  

Properties Panel > Properties Tab > Apply 

How do I save my progress so I will pick up where I left off at a later time?  

ParaView allows you to save a session to a State File.  This file contains the objects in the Pipeline 

Browser and the option and parameter settings for each object in any view windows.  It allows you 

to jump back to a specific analysis, without having to manually record all of the parameter values. 

1. File Menu = Save State  

a. Save State File > Choose a location and name  

How do I load a Saved State File? 

To load a previously-saved State File: 

1. File Menu = Load State  

a. Load State File > Navigate to a Save State file from a previous session 

If the files and State File have been moved since the State File was last saved, the path names will 

have changed.  The pop up window from the Load State File selection allows you to identify all of 

the data files used when the State File was last saved.   

This option also allows you to apply a set of parameters to a different set of data files, making a 

comparative analysis a bit easier. 

How do I change the vertical exaggeration? 

Vertical exaggeration can be adjusted per data object or globally.  

For a single data object, the vertical exaggeration can be adjusted from the Display Tab.  To use the 

Display Tab to set the vertical exaggeration for a single object to 10x:  

Display Tab > Transformation > Scale = 1, 1, 10 

This only works on one object at a time and generally does carry forward to new child objects.  If 

you set the vertical exaggeration for a geologic model to 10, then use a Threshold Filter on this 

model, the Threshold Filter object is automatically set to 10.  However, if you subsequently change 

the original geologic model to 5, the Threshold Filter object is not updated automatically.  Also, 

some filters do not inherit these scaling changes.  For example, the Clip and Slice filters load with 

the default scale values, regardless of vertical, or horizontal, change in scale of the parent filter or 

data object. 
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To simultaneously adjust the vertical exaggeration of all objects in a viewing window, use the new 

Global Z Scale tool. You can input the particular scale factor you want, or use the "+" and "-" 

buttons to incrementally adjust the scale. NOTE: New objects loaded in will NOT be automatically 

scaled. To scale them to size, simply reapply the global scale (i.e. click in the box and hit enter). Also, 

the Global Z Scale will become the default vertical exaggeration and override vertical scaling in 

individual data objects. 

 

How do I add another viewing window to see a different view of my data? 

Each viewing window can be subdivided, and each new window can be set to be a different window 

type (e.g., 3D View, 2D View, Spreadsheet View).  Any active viewing window can be split 

horizontally or vertically using the split window buttons that are located in the upper right hand 

corner of each view window (Fig 1.4). Once the window is split, a list of window types is provided.  

Choose the desired window type.  The active viewing window is identified by a blue border.  The 

data objects that have been included in the active window are identified by black eye icons.  To add 

a data layer to the active window, select the desired window, then select the desired object(s) from 

the Pipeline Browser. 

Fig 1.4: Split Horizontal, Split Vertical, Maximize, Close. 

 

How do I make a data object transparent? 

To change the opacity of an object, you adjust the Opacity field between 0 and 1, with 1 being 

completely opaque and 0 being completely transparent.   

Properties Panel > Display Tab > Style > Opacity = choose a value (e.g., 0.5) 

How do I show the axes for the data?  

The axes are readily drawn for any data layer . 

Properties Panel > Display Tab > Annotation > Show Cube Axes = 

checked/unchecked. 

The details of each axis can also be adjusted. 

Properties Panel > Display Tab > Annotation > Edit (each axis can be adjusted as 

desired) 

I’ve added a second viewing window. How do I make the objects in each window spin together? 

ParaView has the useful option of linking two images in different view ports so that they can both 

be oriented in the same position at the same time. When one image is rotated in one direction the 

other image with the camera link rotates in that direction too.  
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Tools Menu > Add Camera Link 

This opens up a dialog box like the one in Fig 4.3. Click on the window that you want to link with the 

window that has the dialog box. When you click on the other window a link is established. Clicking 

on Zoom To Data might be necessary to focus both the objects correctly. Now rotating one object 

in a certain direction also rotates the other object in that direction. 

Fig 4.3: A dialog box opens when you Add Camera Link. Now click on the window marked in red to establish 

a camera link between the two windows. 

How do I take a screenshot of my creation in ParaView? 

Navigate to File Menu in the menu bar and select Save Screenshot. This opens a dialog box 

with the options to configure the output image file. Click on OK after you make the changes of your 

choice, save the picture and you have a copy of your creation. 

I applied a filter to my data set or object and now it is not visible in the view area. How can I fix this? 

 Make sure the Eye Icon of your data object or filter is highlighted in the Pipeline Browser.  

 If you are using multiple viewing windows, make sure the correct view window is selected.  

 Click on the data object or filter that is missing from the viewing window and try  

Properties Panel > Display Tab > View > Zoom to Data.  

 Update the vertical scaling in each image by clicking the "+" and "-" buttons in the Global Z 

Scale toolbar. 

 In the Camera Controls Toolbar, click the Reset button to reset the camera view. 

 

EXPLORING A GEOLOGIC AND RESERVOIR MODELS 

Geologic Model Examples 

How do I apply a color ramp to my data?  

To shade a volume model by the variations in a variable, first select the variable. 
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 Properties Panel > Display Tab > Color > Color by = Mean of K  

Second, set the color ramp. 

Properties Panel > Display Tab > Color > Edit Color Map > Choose 

Preset = Blue to Red Rainbow 

Finally, if you want a legend, select and configure the legend. 

Properties Panel > Display Tab > Color > Edit Color Map > Color Legend 

Tab > check Show Color Legend. 

You should be able to see an image resembling Figure 5.1. If this image is not drawing on your 

screen, reference the tips to resetting the camera and viewing post-processed data. 

 

 

Note that many display parameters can be set using buttons or pulldown menus on the various 

menu bars within ParaView.  We will try to present methods that are not affected by configuration 

or customization of the User Interface.  

The representation will be affected by the type of representation selected for the object in the 

active window.  The above image shows how a 3-D geologic model would be rendered if the 
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representation was Surface.  Other data representations options and simple color renderings are 

shown below and clarify a range of options that can be used for a single data set. 

 

 

Surface With Edges representation. 

 

Points representation. 
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A Wireframe representation.   

How do I display contours or isosurfaces in my data?  

 

Figure 5.5 A contour filter was used on the permeability values to create the above image.  The contours 

that are displayed are between the range of 100- 250 with a contour interval of 10.   

The contour filter can be used to create a single isosurface, or a set of isosurfaces for a geologic 

model or reservoir simulation.   
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1. Filter Menu > Common Sub Menu  = Contour  

2. Properties Panel > Properties Tab >  

a) Contour > Contour by = choose a variable (e.g., Mean of K )  

b) Contour > check Compute Scalars,  

c) Contour > check Compute Normals 

d) Isosurfaces > click Delete All  

e) Isosurfaces > click New Range > In the Add Range pop up window, Input 

desired range and desired steps (e.g. From = 100, To = 250, Steps = 4) > click OK 

f) click Apply 

3. Properties Panel > Display Tab > Color > Edit Color Map > Color 

Legend Tab > check Show Color Legend. Adjust the parameters as desired. 

You should be able to see an image resembling Figure 5.5. If this image is not drawing on your 

screen, reference the tips to resetting the camera and viewing post-processed data. 

How do I create a cut-away view of my model?  The clip filter 

A clip filter cuts and removes portions of an object, allowing the remaining, uncut portions to 

be rendered.  ParaView provides a few distinct clipping shapes to apply to data: a plane, a box, a 

sphere and a scalar value (of the variable used in the coloring of the object).  The clip can be sized 

and oriented as desired in the properties tab on the properties plane. The clip can also be 

“reversed” by checking the Inside Out check box on the Properties Tab. 

 

 

Figure 5.6 A plane clip filter was used on the permeability values to create the above image on the 

right hand side.  For this image the same data set was opened in two camera views to demonstrate how the 

clip filter works.    
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1. Split the display by clicking Split Horizontal in the viewing area. Click 3D View.  

2. Create a camera link so the both viewing areas are synced.    

3. Filter Menu > Common Sub Menu = Clip   

4. Properties Panel > Properties Tab >  

a. Clip Type = Plane  

b. Click X Normal  

c. Click Apply 

5. Properties Panel > Display Tab > Color > Edit Color Map > Color 

Legend Tab > check Show Color Legend. Adjust the parameters as desired.   

You should be able to see an image resembling Figure 5.6. If this image is not drawing on your 

screen, reference the tips to resetting the camera and viewing post-processed data. 

How do I look at a single row, column, or layer within my model?  The Slice Filter. 

A slice filter cuts and removes everything that is not in contact with the clipping plane.  ParaView 

provides a few clipping planes to apply to the data:  A plane, a box, and a sphere. The slice can be 

sized and oriented as desired in the properties tab on the properties plane. 

 

 

Figure 5.10 A plane slice filter was used on the permeability values to create the above image on the 

right hand side. The slice was applied along the Z Normal option. For this image the same data set was 

opened in two camera views to demonstrate how the plane slice filter works. 

1. Filter Menu > Common Sub Menu = Slice   

2. Properties Panel > Properties Tab >  

a. Slice Type = Plane  
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b. Select Z Normal 

c. Click Apply 

3. Properties Panel > Display Tab > Color > Edit Color Map > Color 

Legend Tab > check Show Color Legend. Adjust the parameters as desired. 

You should be able to see an image resembling Figure 5.10. If this image is not drawing on your 

screen, reference the tips to resetting the camera and viewing post-processed data. 

Can I look at multiple slices?  

The Slice offset values section of the slice filter can be used to create multiple slices.  

 

Figure 5.12 A plane slice filter was used on the permeability values to create the above image on the 

right hand side. The slices for this example were along the Y Normal option with multiple slices. For this 

image the same data set was opened in two camera views to demonstrate how the slice filter works.  

1. Filter Menu > Common Sub Menu = Slice   

2. Properties Panel > Properties Tab >  

a. Slice Type = Plane  

b. Select Y Normal 

c. Slice Offset Values > click Delete All 

d. Click New Range > In the Add Range pop up window, use the default values > click 

OK 

e. Click Apply 

3. Properties Panel > Display Tab > Color > Edit Color Map > Color 

Legend Tab > check Show Color Legend. Adjust the parameters as desired. 
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You should be able to see an image resembling Figure 5.11. If this image is not drawing on your 

screen, reference the tips to resetting the camera and viewing post-processed data. 

How do I look at a specific range of my parameters?  The Threshold Filter and the IsoVolume Filter. 

Both the threshold filter and the isovolume filter allow the user to look a specified range of values 

within their data set. This allows the user to focus in on specific areas of interest.  

 

 

1. Figure 5.12 A threshold filter was used on the porosity values to create the above image on 

the right hand side. For this image the same data set was opened in two camera views to 

demonstrate how the threshold filter works. Filter Menu > Common Sub Menu 

= Threshold   

2. Properties Panel > Properties Tab >  

a. Scalars > Select desired variable (e.g. Mean of Phi)  

b. Lower Threshold > Input desired value (e.g. 17) 

c. Upper Threshold > Input desired value (e.g. 21) 

d. click Apply 

3. Properties Panel > Display Tab > Color > Edit Color Map > Color 

Legend Tab > check Show Color Legend. Adjust the parameters as desired. 

You should be able to see an image resembling Figure 5.12. If this image is not drawing on your 

screen, reference the tips to resetting the camera and viewing post-processed data. 

 

The IsoVolume Filter provides a slightly different rendering of the same data. 
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Figure 5.15 A IsoVolume filter was used on the permeability values to create the above image on the 

right hand side. For this image the same data set was opened in two camera views to demonstrate how the 

IsoVolume filter works.  

1. Filter Menu > Alphabetical Sub Menu = Iso Volume 

2. Properties Panel > Properties Tab >  

a. Scalars > Select desired variable (e.g. Mean of K)  

b. Lower Threshold > Input desired value (e.g. 155) 

c. Upper Threshold > Input desired value (e.g. 255)  

d. click Apply 

3. Properties Panel > Display Tab > Color > Edit Color Map > Color 

Legend Tab > check Show Color Legend. Adjust the parameters as desired.  

You should be able to see an image resembling Figure 5.15. If this image is not drawing on your 

screen, reference the tips to resetting the camera and viewing post-processed data. 
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How do I display my data in a spreadsheet for the filter that I applied in RVA?  

Figure 5.17 A threshold filter was used on the permeability values to create the above image on the left 

hand side. The results of the threshold filter are displayed in the spreadsheet on the right hand side.  

1. Filter Menu > Common Sub Menu = Threshold 

2. Properties Panel > Properties Tab >  

a. Scalar = Desired variable (e.g. Mean of Phi) 

b. Lower Threshold = Input desired lower threshold value (e.g. 155) 

c. Upper Threshold = Input desired upper threshold value (e.g. 255) 

d. Uncheck All Scalars 

e. Click Apply 

3. Properties Panel > Display Tab > Color > Edit Color Map > Color 

Legend Tab > check Show Color Legend.Adjust the parameters as desired. 

4. Split the display by clicking Split Horizontal in the viewing area. Click Spreadsheet 

View. 

5. Spreadsheet >  

a. Showing = Threshold1 

b. Attribute = Point Data 

You should be able to see an image resembling Figure 5.17. If this image is not drawing on your 

screen, reference the tips to resetting the camera and viewing post-processed data. 
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How do I analyze modeled values in a spreadsheet when I used multiple filters?   

 

Figure 5.18 .A slice filter was used on the permeability values to create the above image on the left hand 

side.  The image on the right was created by applying a threshold filter to the slice filter.  The results of 

the threshold filter are displayed in the spreadsheet.  

1. The display will be split into three viewing areas. 

a. Click Split Vertical in the viewing area. Click Spreadsheet View  

b. To split the top viewing area, click Split Horizontal. Click 3D View. 

2. Create a camera link between the top two viewing areas. 

3. Filter Menu > Common Sub Menu = Slice (Note that the top right viewing area 

needs to be selected) 
4. Properties Panel > Properties Tab >  

a. Slice Type = Plane  

b. Click X Normal 

c. Slice Offset Values > click Delete All 

d. Click New Range > In the Add Range pop up window, use the default values > click 

OK 

e. Click Apply   

5. Filter Menu > Common Sub Menu = Threshold (Note that the right viewing area 

needs to be selected)   
6. Properties Panel > Properties Tab >  

a. Scalars > Select desired variable (e.g. Mean of K)  

b. Lower Threshold > Input desired value (e.g. 81) 

c. Upper Threshold > Input desired value (e.g. 256) 



 

43 
 

 
RVA Release 2.5.2                    09-10-2015 

 

  

d. click Apply 

7. Properties Panel > Display Tab > Color > Edit Color Map > Color 

Legend Tab > check Show Color Legend.Adjust the parameters as desired. 

8. Spreadsheet >  

a. Showing = Threshold1 

b. Attribute = Point Data 

You should be able to see an image resembling Figure 5.18. If this image is not drawing on your 

screen, reference the tips to resetting the camera and viewing post-processed data. 

How do I model my borehole data using a glyph filter? 

Figure 5.19 A box type glyph filter was used on the SP_Norm values from a borehole dataset to create the 

above image.   

To create this image, open and load your data set (BoreholeData.vtu). To display your data set, 

reference the section on how to use a color shade on your data. In this example, the variable of 

interest is SP Norm. The first step will apply a Glyph filter.  The second step sets the filter 

attributes. The last step will draw a legend.   

1. Filter Menu > Common Sub Menu  = Glyph  

2. Properties Panel > Properties Tab >  

a) Scalars = Desired Variable (e.g., SP_Norm)  

b) Glyph Type = Box  

c) Unheck Orient (results in orient being turned off) 
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d) Scale Mode = Off  

e) uncheck Mask Points (results in turning off the mask points) 

f) click Apply 

3. Properties Panel > Display Tab > Color > Edit Color Map > Color 

Legend Tab > check Show Color Legend. Adjust the parameters as desired. 

You should be able to see an image resembling Figure 5.19. If this image is not drawing on your 

screen, reference the tips to resetting the camera and viewing post-processed data. 

How do I explore the sweet zone of my reservoir with my core data and normalized SP logs? 

 

Figure 22 Two data sets and a series of filters were applied to create the above image that allows for an 

analysis of the simulated sweet zone permeability structure together with petrophysical core analyses and 

normalized SP logs. 

 

This tutorial begins to show the complexity that  ParaView_RVA can handle.  This tutorial uses the 

low permeability rock to bound the view, then highlights the connectivity within the high 

permeability zone.  Transparency and the surface with edges representations are used to view 

inside the model and help to view the structure of the sweet zone connectivity.  The core porosity 

data are shown as disks, with their radius scaled to the porosity value, and the permeability core 

data is shown as flat triangles, again scaled to measured value.  The density porosity logs are shown 

as colored cylinders.   

To create this image, open and load your data set (Demo.vts). Set the appropriate vertical 

exaggeration (8x) using the Global Z Scale. In the first section, a Threshold filter will be used to 

isolate regions of high permeability.  
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1. Properties Panel > Display Tab >  

a. Style > Representation = Surface With Edges  

b. Color > Color by = Permeability  

2. Filter Menu > Common Sub Menu = Threshold  

3. Properties Panel > Properties Tab >  

a. Scalars = Permeability  

b. Lower Threshold = 220  

c. Upper Threshold = Default value  

d. Click Apply 

4. Properties Panel > Display Tab > 

a. Color > Color by = Permeability 

b. Color > Edit Color Map >  

I. Color Scale Tab > uncheck Automatic Rescale to fit 

Data Range 

II. Color Scale Tab > click Rescale Range > In the Set Range 

pop up window, set Minimum to 0 and Maximum to 250 > click Rescale. 

III. Color Legend Tab > check Show Color Legend 

IV. Click Apply 

c. Style  Representation = Surface with Edges 

d. Line width = 2.0 

e. Opacity = 0.15 

5. In the Pipeline Browser, click twice on the Threshold filter. Rename it to 

“HighPermeability_Threshold”. 
 

 

In this section, a second Threshold filter will be applied to the original data set to isolate regions 

of low permeability.  

1. Click on the your data set (Demo.vts) in the Pipeline Browser.  

2. Filter Menu > Common Sub Menu = Threshold  

3. Properties Panel > Properties Tab >  

a. Scalars = Permeability 

b. Lower Threshold = Default value  

c. Upper Threshold = 90  

d. Click Apply 

4. Properties Panel > Display Tab > 

a. Color > Color by = Permeability 

b. Style  Representation = Surface with Edges 

c. Line width = 1.0 

d. Opacity = 0.10 
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5. In the Pipeline Browser, click twice on the Threshold filter. Rename it to 

“LowPermeability_Threshold”. 

1. Note: The color scaling and legend are identical for LowPermeability_Threshold and 

HighPermeability_Threshold.  

 

Load your borehole data set (Borehole-Demo.vtu). In this section, we use a Glyph filter to visualize 

core vertical permeability values. 

1. Filter Menu > Common Sub Menu = Glyph  

2. Properties Panel > Properties Tab >  

a. Scalars = Core_Kvert  

b. Glyph Type = 2D Glyph 

c. 2D Glyph > Glyph Type = Triangle   

d. 2D Glyph > Check Filled 

e. Scale Mode = scalar 

f. Set Scale Factor > Check Edit 

g. Set Scale Factor = 0.4 

h. Click Apply  

3. Properties Panel > Display Tab > 

a. Color > Color by = Core_Kvert 

b. Color > Edit Color Map > 

I. Color Scale Tab > Choose Preset > choose appropriate 

color scale for variable > Click OK 

II. Color Scale Tab > uncheck Automatic Rescale to fit 

Data Range > Rescale Range > In the Set Range pop up 

window, set Minimum to 10 and Maximum to 250 > Click Rescale. 

III. Click Apply. 

c. Style > Surface with Edges 

d. Transformation > Translate = 0, 30, 0 

4. In the Pipeline Browser, click twice on the Glyph filter. Rename it to 

“Kvert_Glyph”. 

 

In the section below, a second Glyph filter is used and applied to the borehole data set (Borehole-

Demo.vtu) to visualize core porosity values. 

1. Click on the borehole data set (Borehole-Demo.vtu) in the Pipeline Browser. 

2. Filter Menu > Common Sub Menu = Glyph  

3. Properties Panel > Properties Tab >  

a. Scalars = Core_Por  

b. Glyph Type = 2D Glyph 
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c. 2D Glyph > Glyph Type = Circle   

d. 2D Glyph > Check Filled 

e. Scale Mode = scalar 

f. Set Scale Factor > Check Edit 

g. Set Scale Factor = 2.0 

h. Click Apply  

4. Properties Panel > Display Tab > 

a. Color > Color by = Core_Por 

b. Color > Edit Color Map > 

I. Color Scale Tab > Choose Preset > choose appropriate 

color scale for variable > Click OK 

II. Color Legend Tab > Check Show Color Legend 

III. Click Apply.  

c. Style > Surface with Edges 

5. In the Pipeline Browser, click twice on the Glyph filter. Rename it to “Por_Glyph”. 

 

Load your borehole data set (Borehole-Demo.vtu) a third time and set the appropriate vertical 

exaggeration (8x).  

1. Object Inspector > Display Tab > Color > Color by = dphi 

2. Object Inspector > Display Tab > Color > Edit Color Map… = 

Choose Preset 

a. Preset Color Scales= choose appropriate color scale for variable  

3. Object Inspector > Display Tab > Style > Representation = 

Surface 

a. Line Width = 6  

 

In this last section, we visualize only the SP_Norm values in the borehold data set 

(BoreholeData.vtu).  

1. Click on the borehole data set (BoreholeData.vtu) in the Pipeline Browser. Turn on 

its visibility by clicking on the eye icon. 
2. Object Inspector > Display Tab > 

a. Color > Color by = SP_Norm 

b. Color > Edit Color Map > 

I. Color Scale Tab > Choose Preset > choose appropriate 

color scale for variable > Click OK 

II. Color Legend Tab > Check Show Color Legend 

III. Click Apply. 

c. Style > Representation = Surface 
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d. Line Width = 6  

 

After completing this tutorial, you will have: 1) two Threshold filters delineating high and low 

permeability regions in the stratigraphic dataset (Demo.vts) , 2) two Glyph filters highlighting core 

porosity and core vertical permeability of the borehold data set (Borehole-Demo.vtu) , and 3) visualized 

the density porosity values from the borehole data set. 

 

Reservoir Fluid-Flow Simulation Examples 

How do I evaluate simulated oil migration relative to the structural partitioning of my reservoir 

model? 

This tutorial details how to create streamlines of oleic phase flux data, investigate frequency of 

permeability values, and visualize oil flux with permeability connectivity in the reservoir model. 

This tutorial uses sample data set EX20. Load all UTE204.HIST files, UTE204.PERM, and 

UTE204.PROF.  

The first step splits the viewing area into a 3D viewing area and a Line Chart view. Step 2 and 3 

visualize the permeability field. Steps 4 and 5 utilize the Histogram filter to investigate the 

frequency of permeability values in the reservoir model. Step 6 sets up the second layout viewing 

area. The Connected Threshold filter is used in step 7 on the high range permeability values 

found in the histogram from step 6. Step 8 applies the Threshold filter on the connectivity values 

found in the previous step, filtering out only the connected and high permeability values.  

While working in the right 3D viewing area, steps 9-12 detail how to visualize the connected and 

thresholded permeability values from step 8. Step 13 demonstrates how to convert the velocity 

data in the .PROF file into point-centered data which will be used by the Stream Tracer filter in 

Step 14. Steps 14 through 16 demonstrate how to create and visualize streamlines of oleic phase 

flux data. The AppendGeometry filter is used in Step 17 to group well geometries and set 

visualization parameters for all wells. While working in the left 3D viewing area, steps 19 through 

22 details how to layer the connected and thresholded permeability object with the streamlines 

from step 14. 
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1. Set up the viewing areas: 

a. When loading well history files (.HIST), the viewing area may automatically split 

into a 3D View and a Spreadsheet View. If this happens, close the 

Spreadsheet View by clicking on the Close button (X) in the top-right corner 
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of the spreadsheet. See the “Working With Wells” tutorial for more information. To 

correctly set up the viewing area, we need to begin with a single 3D View. 

b. Click Split Horizontal button in the viewing area. Select Line Chart View. 

2. Click on the left-side 3D View, and then click on UTE204.PERM in the Pipeline 

Browser. Turn on its visibility by clicking on the eye icon.  

3. Properties Panel > Display Tab > 

a. Style > Representation = Surface with Edges 

b. Color > Color by = Permeability 

c. Color > Edit Color Map > 

I. Color Scale Tab > click Rescale Data Range 

II. Color Legend Tab > click Show Color Legend 

III. Click Apply 

IV. Click Close 

4. Click on the empty Line Chart on the right-side viewing area, and then click on UTE204.PERM 

in the Pipeline Browser.  

a. Filters Menu > Alphabetical Sub Menu > Histogram 

b. Properties Panel > Properties Tab > 

I. Select Input Array = Permeability 

II. Bin Count = 20 

III. Click Apply. The histogram will be drawn automatically in the Line Chart. 

c. Edit Menu > View Settings > 

I. General > Title = Permeability Histogram 

II. Left Axis > Title > Text = Frequency 

III. Right Axis > Title > Text = Permeability, mD 

IV. Click Apply 

V. Click OK 

5. A quick visual inspection concludes the reservoir model is heavily skewed to low-permeability values. 
Hover the mouse over the second frequency bar in the histogram. This permeability value, 846 mD, 
will be used as input to the Connected Threshold filter in step 7. 

6. Set up the second viewing area. 
a. Open a second viewing Layout tab by clicking on the + icon located at the top of the 

viewing area. A Layout #2 tab will open. Select 3D View. 

b. Click Split Horizontal button in the viewing area. Select 3D View. 
c. Create a camera link between both views. 

7. Click on right 3D viewing area, and then click on UTE204.PERM in the Pipeline Browser. 
a. Filter Menu > RVA Sub Menu > Connected Threshold 

b. Properties Panel > Properties Tab > 

I. Scalars 1 = Permeability 

II. Filter Mode = Only Scalar 1 

III. Threshold Range 1 = 846 – 3760 

IV. Click Apply 

8. Click on the ConnectedThreshold1 object in the Pipeline Browser. 

a. Filter Menu > Common Sub Menu > Threshold 

b. Properties Panel > Properties Tab > 
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I. Scalars = Connectivity 

II. Lower Threshold = 1 

III. Upper Threshold = 32  

IV. Click Apply  

9. Continuing to work in the right 3D viewing area, click on the ConnectedThreshold1 object in the 
Pipeline Browser. Turn on its visibility by clicking on its eye icon.   

10. Properties Panel > Display Tab >  

a. check Show cube axes 

b. Style > Representation = Outline 

11. Click on the Threshold1 object in the Pipeline Browser. Turn on its visibility by 
clicking on its eye icon.   

12. Properties Panel > Display Tab >  

a. Style > Representation = Surface with Edges 

b. Color > Color by = Connectivity 

c. Color > Edit Color Map > 

I. Color Legend Tab > click Show Color Legend 

II. Color Scale Tab > click Rescale to Data Range   

III. Click Apply  

IV. Click Close 
 

13. Click on the left 3D view, and then click on UTE204.PROF in the Pipeline Browser. 
Turn on its visibility by clicking its eye icon.  

a. Filter Menu > Alphabetical Sub Menu = Cell Data to Point 
Data 

b. Properties Panel > Properties Tab > Click Apply 
 

14. Click on CellDatatoPointData1 in the Pipeline Browser. 

a. Filter Menu > Common Sub Menu = Stream Tracer 
b. Properties Panel > Properties Tab > 

I. Stream Tracer Box >  

1. Vectors = Flux02_OLEIC_AQUEOUS 
2. Vector Interpolator Type = Interpolator with 

Point Locator 

3. Integration Direction = BOTH 
4. Integrator Type = Range-Kutta 4-5 
5. Integration Step Unit = Cell Length 
6. Initial Step Length = 0.2 

7. Minimum Step Length = 0.01 

8. Maximum Step Length = 0.5 
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9. Maximum Steps = 2000  

10. Maximum Streamline Length = 1600 

11. Terminal Speed = 1e-12 

12. Maximum Error = 1e-06 

13. Uncheck Compute Vorticity  
II. Seeds Box >  

1. Seed type = Point Source  

2. Check Show Point 

3. Point = enter coordinates 242, 800, 242 

4. Number of Points = 1800 

5. Radius = 800 

III. Click Apply 
 

15. While still working in the left 3D view, click on StreamTracer1 object in the Pipeline 

Browser. Make sure its visibility is turned on. 

16. Properties Panel > Display Tab >  

a. Style > Representation > Surface 

b. Color > Color by = Flux02_Oil_OLEIC  

c. Color > Edit Color Map >  

I. Color Scale Tab >  uncheck Automatically Rescale to Fit 
Data Range 

II. Color Scale Tab > click Rescale Range > 

1. Minimum = 0 

2. Maximum = 0.1 

3. Click Rescale  

III. Color Legend Tab > click Show Color Legend 

IV. Click Apply 

V. Click Close  
 

17. Press and hold the Ctrl key, and click on all of the Position objects linked to each 
UTE204.HIST objects in the Pipeline Browser. Six Position objects should be 
selected/highlighted simultaneously.  

a. Filters Menu > Alphabetical Sub Menu > Append Geometry 

b. Properties Panel > Properties Tab > click Apply 

c. The resulting data object will be named AppendGeometry1. A green arrow and an 
AppendGeometry1 object will appear after each Position object. This filter groups well 
geometries into a single object. Turn on its visibility by clicking its eye icon in the 
Pipeline Browser. 

18. Properties Panel > Display Tab > 

a. Style > Representation = Surface 

b. Style > Line width = 2.0 
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19. Continuing to work in the left 3D viewing area, click on the ConnectedThreshold1 object in 
the Pipeline Browser. Turn on its visibility by clicking on its eye icon.   

20. Properties Panel > Display Tab >  

a. check Show cube axes 

b. Style > Representation = Outline 

21. Click on the Threshold1 object in the Pipeline Browser. Turn on its visibility by 
clicking on its eye icon.   

22. Properties Panel > Display Tab >  

a. Color > Color by = Solid Color 

b. Style > Representation = Surface with Edges 

c. Style > Opacity = 0.20 

 
How can I investigate the relationship between permeability and oil saturation in my 5-spot? 

This tutorial demonstrates how to combine the Append Attributes, Cut Between Wells 

and Threshold filters to investigate inter-well reservoir properties, and the relationship between 

high permeability and simulated oil saturation. Demo dataset EX07 is used in this tutorial.  

 

Load UTEX07.PERM, UTEX07.SATP, and all UTEX07.HIST files. Set the appropriate vertical 

exaggeration (3x). Step 1 splits the viewing area into two horizontally-stacked 3D View plots and 

one Line Chart plot. Steps 2 and 3 visualize well locations and an outline of the reservoir in both 

3D viewing areas. Step 4 demonstrates the use of the Append Attributes filter to group .PERM 

and .SATP into a single data object. Step 5 creates a slice between well 1 and well 13 using the Cut 

Between Wells filter. This diagonal slice intersects with injection wells 3 and 11, and production 
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wells 1, 7, and 13. Step 6 shows how to use the Threshold filter to extract only the high 

permeability regions of the inter-well slice from step 5.  

Steps 7-10 visualize oil saturation in the top-left viewing area. Steps 7 and 8 visualize oil saturation 

in the high permeability selection from step 6. For reference, oil saturation in the slice from step 5 is 

displayed at a low opacity (steps 9 and 10).  

Steps 11-14 visualize permeability in the bottom-left viewing area. Steps 11 and 12 visualize the 

high permeability threshold and selection from step 6. For reference, permeability in the slice from 

step 5 is displayed at a low opacity (steps 13 and 14). 

In Step 15, the Plot Data filter is applied to the high permeability selection. Step 16 

demonstrates how to select data to be plotted in the Line Chart. Step 17 adds axes labels and 

title to the plot.  

 

1. Set up the viewing areas: 

a. When loading well history files (.HIST), the viewing area may automatically split into a 3D 

View and a Spreadsheet View. If this happens, close the Spreadsheet View 

by clicking on the Close button (X) in the top-right corner of the spreadsheet. To correctly 

set up the viewing area, we need to begin with a single 3D View. 

b. Click Split Horizontal button in the viewing area. Select Line Chart View. 

c. In the left-side viewing area, click Split Vertical button. Select 3D View. 

d. Create a camera link between the two 3D viewing areas. 

2. Click on the top-left 3D viewing area.  

a. Click on UTEX07.HIST01 in the Pipeline Browser. Turn on its visibility by clicking 

on the eye icon. Repeat this step for all UTEX07.HIST files.  

b. Click on the concentration data file (utex07.SATP) in the Pipeline Browser. Turn on its 

visibility by clicking on the eye icon. 

i. Properties Panel > Display Tab > check Show cube axes 

ii. Properties Panel > Display Tab > Style > 

Representation = Outline  

3. Click on the bottom-left 3D viewing area. Repeat Steps 2a-b. 

4. Press and hold the Ctrl key, and click on the UTEX07.PERM and UTEX07.SATP objects in the 

Pipeline Browser. Both data objects will be highlighted simultaneously. 

a. Filters Menu > Alphabetical Sub Menu > Append Attributes  

b. Properties Panel > Properties Tab > click Apply  

c. The resulting data object will be named AppendAttributes1. A green arrow and an 

AppendAttributes1 object will appear after each of the objects appended. The 

AppendedAttributes1 object may automatically be visualized in one or both of the 3D 

viewing areas. If this occurs, turn off the object’s visibility by clicking its eye icon in the 

Pipeline Browser.  

5. Click on any of the AppendAttributes1 objects in the Pipeline Browser.   

a. Filters Menu > RVA Sub Menu > Cut Between Wells 

file:///C:/ActiveResearch/RVA/UserManual/UTCHEM-demo_PermOilSat.docx%23LinkedCameras
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b. A Change Input Dialog window will appear. For each of the Available Input 

Ports, we need to select a data object.  

i. Click Data Set, and then select the last AppendAttributes1 object.  

ii. Click Well One, and then select the Position object under UTEX07.HIST1. 

iii. Click Well Two, and then select the Position object under UTEX07.HIST13.  

iv. Click OK 

c. Properties Panel > Properties Tab > click Apply 

6. Click on the CutBetweenWells1 object in the Pipeline Browser.  

a. Filters Menu > Common Sub Menu > Threshold Filter 

b. Properties Panel > Properties Tab >  

i. Scalars = Permeability  

ii. Lower Threshold = 1700  

iii. Upper Threshold = 2410 

iv. Check All Scalars 

v. Click Apply  

7. Click on the top- left 3D viewing area, and then click on the Threshold1 object in the Pipeline 

Browser. Turn on its visibility by clicking on its eye icon.  

8. Properties Panel > Display Tab > 

a. Color > Color by = Saturation02_OIL 

b. Color > Edit Color Map >  

i. Color Scale Tab > uncheck Automatically Rescale to Fit 

Data Range  

ii. Color Scale Tab > click Rescale Range 

1. Minimum = 0  

2. Maximum = 0.65 

3. Click Rescale 

iii. Color Legend Tab > click Show Color Legend   

iv. Click Apply  

v. Click Close 

c. Style > Representation = Surface with Edges 

9. While still working in the top-left viewing area, click on the CutBetweenWells1 object in the 

Pipeline Browser. Turn on its visibility by clicking on its eye icon. 

10. Properties Panel > Display Tab > 

a. Color > Color by = Saturation02_OIL 

b. Style > Representation = Surface  

c. Style > Opacity = 0.30 

11. Click on the bottom- left 3D viewing area, and then click on the Threshold1 object in the 

Pipeline Browser. Turn on its visibility by clicking on its eye icon. 

12. Properties Panel > Display Tab > 

a. Color > Color by = Permeability 

b. Color > Edit Color Map >  

i. Color Scale Tab > uncheck Automatically Rescale to Fit 

Data Range 

ii. Color Scale Tab > click Rescale Range 

1. Minimum = 834  

2. Maximum = 2410 
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3. Click Rescale 

iii. Color Legend Tab > click Show Color Legend   

iv. Click Apply  

v. Click Close 

c. Style > Representation = Surface with Edges 

13. While still working in the bottom-left viewing area, click on the CutBetweenWells1 object in 

the Pipeline Browser. Turn on its visibility by clicking on its eye icon. 

14. Properties Panel > Display Tab > 

a. Color > Color by = Permeability 

b. Style > Representation = Surface with Edges 

c. Style > Opacity = 0.30 

15. Click on the empty Line Chart in the viewing area, and then click on the Threshold1 

object in the Pipeline Browser.  

a. Filters Menu > Alphabetical Sub Menu > Plot Data 

b. Properties Panel > Properties Tab > Click Apply 

16. Properties Panel > Display Tab >  

a. Attribute Mode > Cell Data 

b. X-Axis Data > click Use Data Array > Permeability 

c. Line Series > check Saturation02_Oil. Uncheck all other variables. 

d. Line Style = None 

e. Marker Style = Circle 

17. Edit Menu > View Settings >  

a. General > Chart Title > Text = ${TIME} days 

b. Left Axis > Layout > click Specify the Axis Range 

i. Minimum = -0.05    

ii. Maximum = 0.65 

c. Left Axis > Title = Saturation, % 

d. Bottom Axis > Title > Text = Permeability, mD 

e. Click Apply 

f. Click Ok 

 

To see how the oil saturation varies with permeability with respect to time, use the Time Controls 

Toolbar to navigate time steps.  

How do I see the concentration of oil, water, gas, and/or polymer change over time?  

This demo shows how to visualize phase concentrations, and demonstrates how RVA handles UTCHEM 

simulation time stepping. Before completing this tutorial, activate the Animation View tab by going 

to the View pull down menu. Turn on the VCR Controls and Current Time Controls 

toolbars by going to View > Toolbars. These features are used for playing animation and are 
highlighted in the figure below.  
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The Animation View tab designates the playback mode. VCR Controls are a simple set of VCR-like 

animation controls for navigating through time-history datasets. Current Time Controls shows the 
current time information. The text on the left gives the time value reported by the dataset. The spin box on 
the right gives frame number or index of the current time step. The spin box can be used to move the 
animation to a specific time step. 

 

Load the concentration file from EX01, utex01.CONCP. Set the appropriate vertical exaggeration (5x) using 
the Global Z Scale. The first step is to select the oleic phase concentration and set the visualization 
parameters. The second step details how to create an animation.   

1. Click on the concentration data file (utex01.CONP) in the Pipeline Browser. Turn on its 

visibility by clicking on the eye icon. 
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Properties Panel > Display Tab >  

a. Style > Representation = Surface With Edges  

b. Color > Color by = Concentration02_OIL  

c. Color > Edit Color Map > 

I. Color Scale Tab > uncheck Automatically Rescale to Fit 

Data Range 

II. Color Scale Tab > click Rescale Range.  

1. Minimum = 0.33 

2. Maximum = 0.37 

3. Click Rescale  

III. Color Legend Tab > check Show Color Legend. Adjust the 

parameters as desired. 

IV. Click Apply then Close.   

2. To view how phase concentrations change per time step, we use the animation features in RVA.  

a. Animation View tab > Mode: Snap To TimeSteps  

b. VCR Controls > press Play.  

This will cycle through the time steps.  In the Current Time Controls toolbar, the current time will 

be 3300 at time step 31. 

How do I compare distributions oil, water, gas and polymer in my SP simulation and save an 

animation? 

This demo shows how to create a side-by-side comparison of aqueous and oleic phase concentrations, and 

save an animation of the simulation. Before completing this tutorial, activate the Animation View tab 

by going to the View pull down menu. Turn on the VCR Controls and Current Time 

Controls toolbars by going to View > Toolbars.  

 

Load the concentration file from EX01, utex01.CONCP. Set the appropriate vertical exaggeration (5x) using 
the Global Z Scale. The first step is to split the viewing area, and then link the two camera views. The third 
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and fourth steps select the aqueous and oleic concentration, respectively, and visualization parameters for 
each. The fifth step details how to advance time steps, create an animation with the dataset, and save the 
animation as an .avi file.  

1. Split the display by clicking Split Horizontal in the viewing area. Click 3D View. 

2. Create a camera link so both viewing areas are synced. 

3. Click on the left viewing panel. Click on the concentration data file (utex01.CONP) in the Pipeline 

Browser. Turn on its visibility by clicking on the eye icon. 

Properties Panel > Display Tab >  

a. Style > Representation = Surface With Edges  

b. Color > Color by = Concentration01_WATER  

c. Color > Edit Color Map > 

I. Color Scale Tab > uncheck Automatically Rescale to Fit 

Data Range 

II. Color Scale Tab > click Rescale Range.  

1. Minimum = 0.64 

2. Maximum = 0.67 

3. Click Rescale  

III. Color Legend Tab > check Show Color Legend. Adjust the 

parameters as desired. 

IV. Click Apply then Close.   

4. Click on the right viewing panel. Click on the concentration data file (utex01.CONP) in the Pipeline 

Browser. Turn on its visibility by clicking on the eye icon. 

Properties Panel > Display Tab >  

a. Style > Representation = Surface With Edges  

b. Color > Color by = Concentration02_OIL  

c. Color > Edit Color Map > 

I. Color Scale Tab > uncheck Automatically Rescale to Fit 

Data Range 

II. Color Scale Tab > click Rescale Range.  

1. Minimum = 0.33 

2. Maximum = 0.37 

3. Click Rescale  

III. Color Legend Tab > check Show Color Legend. Adjust the 

parameters as desired. 

IV. Click Apply then Close.   

5. To view how phase concentrations change per time step, we use the animation features in RVA.  

a. Animation View tab > Mode: Snap To TimeSteps  

b. VCR Controls > press Play. This will cycle through the time steps.  In the 

Current Time Controls toolbar, the current time will be 3300 at time step 31.   

6. To save the animation:  

a. File > Save Animation. The Animation Settings Dialog box will 

appear.  

b. Animation Settings Dialog >  
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I. Frame Rate (fps) = 1.00 (default)  

II. No. of Frames / timestep = 1 (default)  

III. click Save Animation. 

Working with UTCHEM Well Data in RVA 

This tutorial shows how to use RVA’s Well Reader and visualize UTCHEM well history data. Sample data set 
EX07 is used in this tutorial. This tutorial has five parts. Part 1 details how wells are represented in RVA, and 
how to view well history data in the Spreadsheet View. Part 2 demonstrates how to visualize well geometry 
with permeability. Parts 3 and 4 demonstrate how to plot the timed well history data in line charts. Part 5 
shows how to rename wells and use the Append Geometry filter to group well geometry for quick 
visualization.  

Load all well history files (UTEX07.HIST01 through UTEX07.HIST13) and UTEX07.PERM. There are 9 
production wells and 4 injection wells. The injection well history files are UTEX07.HIST03, 
UTEX07.HIST06, UTEX07.HIST08, and UTEX07.HIST11. The remaining well history files are production 
wells.  

 

Part 1: Well Representation in RVA 

In RVA, a well file is represented by two data objects: Position and History. 

1. When loading well history files, the viewing area will automatically split into a 3D View on the left-

side and a Spreadsheet View on the right-side. Click on the Spreadsheet View on the 

right-hand side of the viewing area. 

2. In the Pipeline Browser, click on the eye icon of the Position object of UTEX07.HIST01. 

This is the well’s geometry. The points are well coordinates.  
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3. In the Pipeline Browser, click on the eye icon of the History object of UTEX07.HIST01. 
This table contains the production well history data (Total Production, Water/Oil Ratio, Cumulative 
Oil Recover, etc.). 

 

4. In the Pipeline Browser, click on the eye icon of the History object of UTEX07.HIST03. 
This table contains the injection well history data (Total Injection, Total Injection Rate, etc.).  
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Part 2: Visualizing All Wells 

 

1. Set the appropriate vertical exaggeration (3x) using the Global Z Scale. 

2. Click on the 3D View on the left-side of the viewing area. Click on .PERM in the Pipeline 

Browser. Turn on its visibility by clicking on the eye icon. 

3. Properties Panel > Display Tab > 

a. Color > Color by = Permeability 

b. Style > Representation = Surface With Edges 

c. Style > Opacity = 0.20 

4. Click on the Position object of UTEX07.HIST01 in the Pipeline Browser. Turn on its visibility by 

clicking on eye icon.  

5. Properties Panel > Display Tab > 

a. Color > Color by = Solid Color 

b. Style > Representation = Surface With Edges 

c. Style > Line width = 3.00 

6. Repeat Steps 4 and 5 for the remaining well history files. 

 

Part 3: Visualizing Production Well Data  
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1. Open a second viewing Layout tab by clicking on the + icon in the top left of the viewing area. Select 

Line Chart View. 

2. In the Pipeline Browser, click the eye icon of History object of UTEX07.HIST01. All 

variables in the well history file will be plotted in the line chart as a time series. 

3. To select a single variable, go to Display Panel > Display Tab > Line Series > 

a. Check and then uncheck the first box next to the column title “Variable”. This will clear the 

line chart of all line series. 

b. Check the box next to Cumulative Oil Recovery 

4. Edit Menu > View Settings >  

a. General > Chart Legend > Location > select Bottom-right 

(inline) 

b. Left Axis > Title > Text = cubic ft 

c. Bottom Axis > Title > Text = Time, days 

d. Click Apply 

e. Click OK 

Part 4: Visualizing Injection Well Data  
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1. In the Pipeline Browser, unclick the eye icon of History object of UTEX07.HIST01. Click 

the eye icon of History object of UTEX07.HIST03. All variables in the well history file will be 

plotted in the line chart as a time series. 

2. To select a single variable, go to Properties Panel > Display Tab > Line Series 

>  

a. Check and then uncheck the first box next to the column title “Variable”. This will clear the 

line chart of all line series. 

b. Check the box next to Total Injection Rate 

3. Edit Menu > View Settings > 

a. Left Axis > Title > Text = cubic ft per day 

b. click Apply 

c. click OK 

 

Part 5: Renaming and Grouping Wells 
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1. Open a third viewing Layout tab by clicking on the + icon in the top left of the viewing area. Select 

3D View. 

2. The injection well history files are UTEX07.HIST03, UTEX07.HIST06, UTEX07.HIST08, and 

UTEX07.HIST11. To rename these files: 

a. Click on UTEX07.HIST03 in the Pipeline Browser. 

b. To rename the file, click again. A blinking text entry cursor will appear. Note: A rapid 

double-click will collapse or close the sub-pipeline. Add “INJ” to the file name. The revised 

name should be “UTEX07.HIST03 INJ”. 

c. Repeat this step for the remaining injection well history files by adding INJ to the end of the 
file names. 

3. Press and hold the Ctrl key, then click on injection well history files in the Pipeline Browser.  

a. Filter Menu > Alphabetical Sub Menu = Append Geometry 

b. Properties Panel > Properties Tab > Click Apply 

4. In the Pipeline Browser, click on AppendGeometry1. Click again, and rename it to “Injection 

Well Geometry”.  

5. Properties Panel > Display Tab > 

a. Color > Color by = Solid Color 

b. Style > Representation = Surface With Edges 

c. Style > Line width = 7.0 

d. Edge Style > Set Edge Color > choose red > click OK 

6. Press and hold the Ctrl key, then click on production well history files (.HIST01, .HIST02, .HIST04, 

.HIST05, .HIST07, .HIST09, .HIST10, .HIST12, and .HIST13) in the Pipeline Browser. 

a. Filter Menu > Alphabetical Sub Menu = Append Geometry 

b. Properties Panel > Properties Tab > Click Apply 
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7. In the Pipeline Browser, click on AppendGeometry2. Click again, and rename it to 

“Production Well Geometry”. 

8. Properties Panel > Display Tab > 

a. Color > Color by = Solid Color 

b. Style > Representation = Surface With Edges 

c. Style > Line width = 3.0 

d. Edge Style > Set Edge Color > choose black > click OK 

9. Click on .PERM in the Pipeline Browser. Turn on its visibility by clicking on the eye icon. 

10. Properties Panel > Display Tab > 

a. Color > Color by = Permeability 

b. Style > Representation = Surface With Edges 

c. Style > Opacity = 0.20  

How do I compare UTCHEM simulations? 

This demo demonstrates how to compare simulations. EX01 (surfactant-polymer flood) and EX01b (polymer 
flood) are used in this tutorial. This tutorial consists of three parts. Part one details how to create a side-by-
side comparison of oil saturation in a 3D View. Part two shows how to compare histograms of oil saturation 
at the final time step of the simulations. Part 3 is comprised of two demos. The first demo shows how to 
create comparative time series plots of production well data. Cumulative oil recovery and water-oil ratio 
between the simulations are compared. The second demo focuses on the SP flood (EX01). Time series of 
various production well data are plotted in order to investigate the effect of surfactant on oil recovered. 

Load the well and saturation files from EX01 (utex01.HIST01, utex01.HIST02, utex01.SATP) and EX01b 
(utex01b.HIST01, utex01b.HIST02, utex01b.SATP). Set the appropriate vertical exaggeration (5x) using the 
Global Z Scale.  

Part 1: Comparing Oil Saturation in 3D Views  

 

1. Set up the viewing areas: 
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a. When working with well files, the viewing area may split into a 3D View and a 

Spreadsheet View. If this happens, close the Spreadsheet View by clicking on 

the Close button (X) in the top-right corner of the spreadsheet. To correctly set up the 

viewing area, we need to begin with a single 3D View. 

b. Split the display by clicking Split Horizontal in the viewing area. Click 3D View. 

c. Create a camera link between the two 3D viewing areas. 

2. Click on the left viewing panel. Click on the saturation data file for the surfactant-polymer flood 

(utex01.SATP) in the Pipeline Browser. Turn on its visibility by clicking on the eye icon. 

3. Properties Panel > Display Tab >  

a. Style > Representation = Surface With Edges  

b. Color > Color by = Saturation02_Oil  

c. Color > Edit Color Map > 

I. Color Scale Tab > uncheck Automatically Rescale to Fit 

Data Range 

II. Color Scale Tab > click Rescale to Temporal Range.  

III. A warning window will appear. Click OK. 

IV. Color Legend Tab > check Show Color Legend. Adjust the 

parameters as desired. 

V. Color Legend Tab > Title = SP – Oil Saturation 

VI. Click Apply.  

VII. Click Close.   

4. Click on the right viewing panel. Click on the saturation data file for the polymer flood 

(utex01b.SATP) in the Pipeline Browser. Turn on its visibility by clicking on the eye icon. 

5. Properties Panel > Display Tab >  

a. Style > Representation = Surface With Edges  

b. Color > Color by = Saturation02_Oil  

c. Color > Edit Color Map > 

I. Color Legend Tab > check Show Color Legend. Adjust the 

parameters as desired. The color ramps in each 3D View should be 

synchronized. 

II. Color Legend Tab > Title = P – Oil Saturation 

III. Click Apply. 

IV. Click Close.   

6. To add a time stamp to both 3D Views: 

a. Source menu > Annotate Time  

b. Properties Panel > Properties Tab > 

I. Format = Time: %.2f days  

II. Click Apply. 

c. In each 3D View, turn on the AnnotateTime1 object in the Pipeline Browser. 

7. Using the Time Controls Toolbar, navigate to the last time step (3300 days).  

 

 

Part 2: Comparing simulated oil saturation using histograms 
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1. Set up a second viewing area. 

a. Open a second viewing Layout tab by clicking on the + icon located at the top of the 

viewing area. A Layout #2 tab will open. Select Bar Chart View. 

b. Click Split Horizontal button in the viewing area. Select Bar Chart View. 

2. Click on the left Bar Chart View. 

3. In the Pipeline Browser, click on utex01.SATP.  

a. Filters Menu > Alphabetical submenu > Histogram 

b. Properties Panel > Properties Tab > 

I. Select Input Array = Saturation02_Oil 

II. Bin Count = 10 

III. Check Calculate Averages 

IV. Click Apply. 

4. Edit Menu > View Settings > 

a. General > Chart Title > Text = Histogram of SP - Oil Saturation at 

${TIME} days 

b. Left Axis > Title > Axis Title > Text = Count 

c. Bottom Axis > Title > Axis Title > Text = Saturation, % 

d. Click Apply. 

e. Click OK. 

5. Click on the right Bar Chart View. 

a. Filters Menu > Alphabetical submenu > Histogram 

b. Properties Panel > Properties Tab > 

I. Select Input Array = Saturation02_Oil 

II. Bin Count = 10 

III. Check Calculate Averages 

IV. Click Apply. 

6. Edit Menu > View Settings > 
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a. General > Chart Title > Text = Histogram of P - Oil Saturation at ${TIME} 

days 

b. Left Axis > Title > Axis Title > Text = Count 

c. Bottom Axis > Title > Axis Title > Text = Saturation, % 

d. Click Apply. 

e. Click OK. 

 

 

Part 3: Comparing and Visualizing Well Recovery Data  

 

How do I compare cumulative oil recovery and water-to-oil ratios between two simulations? 

1. Set up a third viewing area. 

a. Open a third viewing Layout tab by clicking on the + icon located at the top of the viewing 

area. A Layout #3 tab will open. Select Line Chart View. 

b. Click Split Horizontal button in the viewing area. Select Line Chart View. 

2. Click on the left Line Chart View. 

3. In the Pipeline Browser, click on the History object of utex01.HIST02. Turn on its visibility 

by clicking on its eye icon. All variables in the well history file will be plotted in the line chart as a 

time series. 

4. To select a single variable to be plotted as a time series, go to Properties Panel > 

Display Tab > 

a. Attribute Mode = Row Data  

b. X Axis Data > select Use Data Array = Time 

c. Line Series >  

I. Check and then uncheck the first box next to the column title “Variable”. This will 

clear the line chart of all line series 

II. Check the box next to Cumulative Oil Recovery 
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III. Rename the line series by clicking on the Legend Name twice. Change the name 

to “S/P flood” 

d. Line Style > Solid 

5. In the Pipeline Browser, click on the History object of utex01b.HIST02. Turn on its visibility 

by clicking on its eye icon. All variables in the well history file will be plotted in the line chart as a 

time series.  

6. To select a single variable to be plotted as a time series, go to Properties Panel > 

Display Tab >  

a. Attribute Mode = Row Data  

b. X Axis Data > select Use Data Array = Time 

c. Line Series >  

I. Check and then uncheck the first box next to the column title “Variable”. This will 

clear the line chart of all line series 

II. Check the box next to Cumulative Oil Recovery 

III. Rename the line series by clicking on the Legend Name twice. Change the name 

to “P flood” 

d. Line Style > Dashed 

7. Edit Menu > View Settings > 

a. General > Chart Title > Text = Cumulative Oil Recovery 

b. Left Axis > Title > Axis Title > Text = % 

c. Bottom Axis > Title > Axis Title > Text = Time, days 

d. Click Apply. 

e. Click OK. 

8. Click on the right Line Chart View. 

9. In the Pipeline Browser, click on the History object of utex01.HIST02. Turn on its visibility 

by clicking on its eye icon. All variables in the well history file will be plotted in the line chart as a 

time series. 

10. To select a single variable, go to Properties Panel > Display Tab > Line 

Series > 

a. Attribute Mode = Row Data 

b. X Axis Data > select Use Data Array = Time 

c. Line Series >  

I. Check and then uncheck the first box next to the column title “Variable”. This will 

clear the line chart of all line series 

II. Check the box next to Water/Oil Ratio 

III. Rename the line series by clicking on its Legend Name twice. Change the name 

to “S/P flood” 

d. Line Style > Solid 

11. In the Pipeline Browser, click on the History object of utex01b.HIST02. Turn on its 

visibility by clicking on its eye icon. All variables in the well history file will be plotted in the line 

chart as a time series.  

12. To select a single variable to be plotted as a time series, go to Properties Panel > 

Display Tab >  
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a. Attribute Mode = Row Data 

b. X Axis Data > select Use Data Array = Time 

c. Line Series >  

I. Check and then uncheck the first box next to the column title “Variable”. This will 

clear the line chart of all line series 

II. Check the box next to Water-Oil Ratio 

III. Rename the line series by clicking on the Legend Name twice. Change the name 

to “P flood” 

d. Line Style > Dashed 

13. Edit Menu > View Settings > 

a. General > Chart Title > Text = Water-Oil Ratio 

b. Left Axis > Layout > Axis Layout >  

I. Select Specify the Axis Range 

II. Minimum = 0 

III. Maximum = 10000  

c. Left Axis > Title > Axis Title > Text = Fraction, % 

d. Bottom Axis > Title > Axis Title > Text = Time, days 

e. Click Apply. 

f. Click OK. 

 

 

How do I investigate the effect of injected surfactant on oil recovered? 

 
1. Set up a third viewing area. Open a third viewing Layout tab by clicking on the + icon located at the 

top of the viewing area. A Layout #3 tab will open. Select Line Chart View. 

2. In the Pipeline Browser, click on the History object of utex01.HIST02. Turn on its visibility 

by clicking on its eye icon. All variables in the well history file will be plotted in the line chart as a 

time series. 
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3. To select variables to be plotted as time series, go to Properties Panel > Display Tab 

> 

a. Attribute Mode = Row Data  

b. X Axis Data > select Use Data Array = Time 

c. Line Series >  

I. Check and then uncheck the first box next to the column title “Variable”. This will 

clear the line chart of all line series 

II. Check the boxes next to Cumulative Oil Recovery, Phase Cut Oil, OIL total, and 

SURF. total. 

4. Edit Menu > View Settings > 

a. General > Chart Title > Text = S-P Oil Recovery 

b. Left Axis > Title > Axis Title > Text = % 

c. Bottom Axis > Title > Axis Title > Text = Time, days 

d. Click Apply. 

e. Click OK. 

How do I visualize fluid flow in my simulation?  

This demo shows how to add streamlines to velocity data printed in the .PROF file. Streamlines can be used 

to evaluate efficiency of injection and production wells, rank water flood production scenarios, identify 

preferential flow paths related to geologic structures, and determine the reservoir volume associated with a 

given well in the reservoir. This tutorial shows how to visualize fluid flow in the entire reservoir and about a 

single injection well. 

Load all UTEX07.HIST files and UTEX07.PROF. Set the appropriate vertical exaggeration (3x) using the 

Global Z Scale. When loading well history files (.HIST), the viewing area may automatically split into a 3D 

View and a Spreadsheet View. If this happens, close the Spreadsheet View by clicking on the 

Close button (X) in the top-right corner of the spreadsheet. To correctly set up the viewing area, we need to 

begin with a single 3D View. 

The first step visualizes the wells. The second step renames the injection well history files. The third step 

converts the velocity data in the .PROF file into point-centered data. The fourth, fifth, and sixth steps detail 

how to use the Stream Tracer and Glyph filters to visualize aqueous flux data in the entire reservoir. The 

seventh through eleventh steps detail how to find coordinates of a specific well, and how to adjust parameters 

of the Stream Tracer and Glyph filters to visualize aqueous flux data about a single production well. 

1. Click on UTEX07.HIST01 in the Pipeline Browser. Turn on its visibility by clicking on the 

eye icon. Repeat this step for all UTEX07.HIST files. 

2. The injection well history files are UTEX07.HIST03, UTEX07.HIST06, UTEX07.HIST08, and 

UTEX07.HIST11. To rename these files: 

a. Click on UTEX07.HIST03 in the Pipeline Browser.  

b. To rename the file, click again. A blinking text entry cursor will appear. Note: A rapid 

double-click will collapse or close the sub-pipeline. Add “INJ” to the file name. The revised 

name should be “UTEX07.HIST03 INJ”.  

c. Repeat this step for the remaining injection well history files by adding INJ to the end of the 

file names. 



 

73 
 

 
RVA Release 2.5.2                    09-10-2015 

 

  

3. Click on UTEX07.PROF in the Pipeline Browser. 

a. Filter Menu > Alphabetical Sub Menu = Cell Data to Point 

Data 

b. Properties Panel > Properties Tab > Click Apply 

 

 

 

Visualizing Fluid Flow: In the Entire Reservoir 

4. Click on CellDatatoPointData1 in the Pipeline Browser. 

a. Properties Panel > Display Tab > 

I. Color by > Solid Color 

II. Style > Representation = Outline 

III. Check Show cube axes 

b. Filter Menu > Common Sub Menu = Stream Tracer 

c. Properties Panel > Properties Tab > 

I. Stream Tracer Box >  

1. Vectors = Flux01_Water_AQUEOUS 

2. Vector Interpolator Type = Interpolator with 

Point Locator 

3. Integration Direction = BOTH 

4. Integrator Type = Range-Kutta 4-5 

5. Integration Step Unit = Cell Length 

6. Initial Step Length = 0.2 

7. Minimum Step Length = 0.01 

8. Maximum Step Length = 0.5 

9. Maximum Steps = 2000  

10. Maximum Streamline Length = 361 

11. Terminal Speed = 1e-12 
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12. Maximum Error = 1e-06 

13. Uncheck Compute Vorticity  

II. Seeds Box >  

1. Seed type = Point Source  

2. Check Show Point 

3. Point = enter coordinates 180.5, 180.5, 20 

4. Number of Points = 3000 

5. Radius = 200 

III. Click Apply   

5. Click on StreamTracer1 in the Pipeline Browser. 

a. Properties Panel > Display Tab > 

I. Color > Color by = Flux01_Water_AQUEOUS 

II. Color > Edit Color Map > Color Legend Tab > check Show 

Color Legend. Adjust the parameters as desired. 

III. Style > Representation = Surface 

IV. Style > Opacity = 0.5 

b. Filter Menu > Common Sub Menu = Glyph 

c. Properties Panel > Properties Tab > 

I. Vectors = Flux01_Water_AQUEOUS  

II. Glyph Type = Arrow 

III. Check Orient 

IV. Scale Mode = off 

V. Set Scale factor = 10 

VI. Maximum Number of Points = 2000 

VII. Check Mask Points 

VIII. Check Random Mode 

IX. Click Apply 

6. Click on Glyph1 in the Pipeline Browser. 

a. Properties Panel > Display Tab > 

I. Style > Representation = Surface 

II. Color > Color by = GlyphVector 

III. Color > Edit Color Map > Color Legend Tab > check Show 

Color Legend. Adjust the parameters as desired 
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Visualizing Fluid Flow: About a production well 

7. In the Viewing Area, click on the + Layout tab to add a second Viewing Area. Select Spreadsheet 

View. In the Showing dropdown menu, select UTEX07.HIST08 (Position). In the Attribute 

dropdown menu, select Point Data. This will display the well coordinates of UTEX07.HIST08.  The 

second row coordinates (256, 256, 20) will be used in the next step. 

8. In the Pipeline Browser, turn off visibility of StreamTracer1 and Glyph1 from the previous 

steps.  

9. Click on CellDatatoPointData1 in the Pipeline Browser. 

a. Filter Menu > Common Sub Menu = Stream Tracer 

b. Properties Panel > Properties Tab > 

I. Stream Tracer Box >  

1. Vectors = Flux01_Water_AQUEOUS 

2. Vector Interpolator Type = Interpolator with 

Point Locator 

3. Integration Direction = BOTH 

4. Integrator Type = Range-Kutta 4-5 

5. Integration Step Unit = Cell Length 

6. Initial Step Length = 0.2 

7. Minimum Step Length = 0.01 

8. Maximum Step Length = 0.5 

9. Maximum Steps = 2000  

10. Maximum Streamline Length = 361 

11. Terminal Speed = 1e-12 

12. Maximum Error = 1e-06 

13. Uncheck Compute Vorticity  

II. Seeds Box >  

1. Seed type = Point Source  

2. Check Show Point 
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3. Point = enter coordinates 256.5, 256.5, 20 

4. Number of Points = 200 

5. Radius = 50 

III. Click Apply   

10. Click on StreamTracer2 in the Pipeline Browser. 

a. Properties Panel > Display Tab > 

I. Color > Color by = Flux01_Water_AQUEOUS 

II. Color > Edit Color Map > Color Legend Tab > check Show 

Color Legend. Adjust the parameters as desired. 

III. Style > Representation = Surface 

IV. Style > Opacity = 0.5 

b. Filter Menu > Common Sub Menu = Glyph 

c. Properties Panel > Properties Tab > 

I. Vectors = Flux01_Water_AQUEOUS  

II. Glyph Type = Arrow 

III. Check Orient 

IV. Scale Mode = off 

V. Set Scale factor = 10 

VI. Maximum Number of Points = 1000 

VII. Check Mask Points 

VIII. Check Random Mode 

IX. Click Apply 

11. Click on Glyph2 in the Pipeline Browser. 

a. Properties Panel > Display Tab > 

I. Style > Representation = Surface 

II. Color > Color by = GlyphVector 

III. Color > Edit Color Map > Color Legend Tab > check Show 

Color Legend. Adjust the parameters as desired. 
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APPENDIX 

Descriptions of UTChem demo data sets 

All UTChem demo data sets were simulated using UTChem v9.3. All time intervals for output files are 

written in days.  

EX01 

Sample dataset EX01 is a 3D surfactant polymer water flood with one injection well and one production well. 
Grid dimensions are 11x11x2. The flooding sequence consists of a surfactant-polymer slug plus tracer 
injection followed by a polymer injection. Total simulation time is 3300 days.  

EX01b 

Sample dataset EX01b is a 3D polymer water flood with one injection well and one production well. Grid 
dimensions are 11x11x2. Total simulation time is 3300 days.  

EX07 

Sample dataset EX07 is a 3D comprehensive ASP water flood consisting of 4 injection wells and 9 

production wells in an inverted five-spot well pattern. Grid dimensions are 19x19x3. The ASP process was 

conducted in a 4-slug sequence: pre-flush polymer flood, alkaline/surfactant slug, 

alkaline/surfactant/polymer slug, and a polymer drive. Total simulation time is 551 days. Reservoir properties 

include heterogeneous permeability and initial water saturation fields. 

EX08 

Sample dataset EX08 is a 3D water flood with 4 injection wells and 9 production wells. Grid dimensions are 

19x19x3. Total simulation time is 551 days. Reservoir properties include heterogeneous permeability and 

initial water saturation fields. 

EX20 

Sample dataset EX20 is a 3D water flood with 4 injection wells and 3 production wells. The reservoir is a 

buried river channel with heterogeneous permeability and porosity. Grid dimensions are 20x40x24. Total 

simulation time is 730 days. 

EX50 

Sample dataset EX50 is a pre-SEAR tracer test at Hill Air Force Base. There are 4 injection wells and 4 

production wells. Test sequence consists of an initial 99 day waiting period, pre-test water extraction, pre-test  

water flush, tracer injection, and a post-tracer test water flush. Grid dimensions are 20x17x6. Total simulation 

time is 106.5 days. 

EX51 

Sample dataset EX51 is a Phase 2 SEAR test at Hill Air Force Base. There are 4 injection wells and 4 

production wells. The flooding sequence consists of water pre-flush, surfactant injection, and a water drive. 

Grid dimensions are 20x17x6. Total simulation time is 22.4 days. 
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EX52 

Sample dataset EX52 is a SEAR process based on the Camp Lejeune field test. There are two injection wells 

to model oil spillage, two remediation injection wells, and 24 remediation production wells. Grid dimensions 

are 25x25x16. Total simulation time is 140 days. 

EX53 

Sample dataset EX53 is a Phase II SEAR test. The flooding sequence consists of two phases, separated by a 

three month resting period. Phase I: pre-test water flush, tracer injection, post-tracer water flush, surfactant 

injection, post-surfactant water flush, and a water extraction test. Phase II: pre-test water flush, tracer 

injection, post-tracer water flush, water + chloride injection, surfactant injection, post-surfactant water flush, 

tracer test, post-tracer flush, and water extraction test. Grid dimensions are 20x17x6. Total simulation time is 

227 days. 
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